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Dynamic Web Charts

Dynamic Web Charts allows you to create static or dynamic charts for your website. Whether static or dynamic, the
process of creating your own attractive chart for your website takes only a few minutes. The easy-to-use tabbed
interface makes customizing the appearance of your chart a straightforward process.

Static or Dynamic?

Most users will find that a static chart provides all the features necessary to display the data they need on their
website. When creating static charts, you do not need to have any knowledge of database management. From within
the Dynamic Web Charts interface, you can import data from a CSV file, or manually enter the data you would like
displayed on your chart.

Dynamic Web Charts makes creating dynamic charts very simple. With a functional database connection, any user
can create a dynamic chart that pulls data from a database and automatically updates when more records are added.
For help creating a dynamic chart, check out the Dynamic Web Charts Solution Recipe.




Dynamic Web Charts Editor
The Dynamic Web Charts Editor provides you with an array of options and settings that allow complete customization of your chart.

The following sections detail the tabs within the interface and the configuration options available in each:

. Chart: The Chart tab allows you to specify the general settings for the chart, including the type of chart, style and design.
. Data: The Data tab configures what data to be displayed in your chart, whether static or dynamic.

. Axes: The Axes tab provides options for customizing how each of your axes will appear in your chart. This option is not available if
using the Pie chart type.

. Background: The Background tab allows you to specify the colors or background image to be used in the background of your chart.

Access

The following locations in Dreamweaver open the interface to create a new Dynamic Web Chart.
. WebAssist Insert panel
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Wizard Reentry
After creating your Dynamic Web Chart, you may want to reenter the Dynamic Web Chart Editor interface to make additional changes.

To reenter the Dynamic Web Chart Editor, follow these steps:

. Select the Dynamic Web Charts placeholder on your Dreamweaver page.

. From the Properties Inspector, choose Edit in Wizard.




Chart
The Chart tab allows you to specify the general settings for the chart, including the type of chart, style and design.

Dynamic Web Charts Editor ==

Set the general Iayuut information for ﬂ'1|s chart. Select a new chart style and design, choose a chart type, and then spedify your chart title,
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Style
. Style: Select from a number of preset styles, or a custom style that you have created or imported.
. Design: Select from a number of preset designs. When selecting a custom design, this option is not available.

Your chart's style and design can be further modified in the other tabs of the Dynamic Web Charts Editor.

Style
Style: | Clean -
Design: |Deep Jungle -
Presets

@ Don'tsave a preset
(1 Owerwrite existing preset

(71 Create new preset

Mame:

Don't generate chart, but save preset

Chart

The Chart section allows you to configure the type of chart you intend to use. Options in this section vary based on your selection in the
Type menu.

Chart
Type: [Mea v]
Subtype: [Smndard v]

Width: 320
Height: 240
Title: My Chart Title

Style: E #d7eafo

Align: [Center -




Type: Choose the type of chart you wish to create. Chart type options are Area, Line, Bar, and Pie.
Subtype: Provides various preset options for the appearance of the data area in your chart.
Options vary depending on chart type, and include:

s Area - Standard

s Line - Standard, Dot, and Hollow

s Pie - Standard

o Bar - Standard, Outline, Glass, Sketch, 3D, and Fade
Width: Specify the total width of your chart. Use the menu list to specify pixels or percent.
Height: Specify the total height of your chart. Use the menu list to specify pixels or percent.
Title: Enter a title for your chart.

Style: Allows you to specify the styling for your chart title. Choose from the menu list to specify type size. Use the color picker to select a
color for your chart title text.

Align: Choose the alignment for your chart title. Options are, left, center, and right.




Data
The Data tab allows you to set the properties for the data that the chart will display.

Choose either Static or Dynamic from the radio buttons, depending on the type of data you plan to display in your chart. The options
available in this tab change based on your selection.

Dynamic Web Charts Editor ==

Speuﬁf the type of data your chart is to display. For dynamic data, select your data source, then select the columns that contain data for your
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Static

By default the Static radio button is selected, allowing you to manually enter the data to display in your chart.

. Get Data from CSV: Allows you to specify a comma-separated values file that contains your data, to be imported into your chart. This data
can be modified by the fields below. A sample CSV file has been provided for reference in the Additional Resources section.

. Clear sample data: Removes sample data from all fields allowing you to enter your own data.

Reset sample data: Replaces all content in fields with the original sample data.

Data type:”) Dynamic i@ Static

[ Get data from CSV ] [ Clear sample data ] [ Reset sample data ]

Labels: Monday[Tuesday|Wednesday [Thursday |Friday

Values: 100]120]105/95/110

Links:

Dataset label: Support Posts

Dataset label style: ﬂ #7657

Lire,Fill mlur:ﬂ #2d2b2e | Edit Color(s)
Cutline mlur:ﬂ #767arf

Labels: Enter the values for the X-axis labels. Each value must be separated by the pipe character, |.
. Values: Enter the values for the Y-axis labels. Each value must be separated by the pipe character, |.

. Links: Allows you to specify URLs for each data point. This option is not available for the Area chart type. Each URL must be separated by
the pipe character, |.

Note: These links are not active in the Preview window.
Dataset label: Enter a label for your dataset.
Dataset label style: Specify the type size and color for your dataset label.

Line/Fill color: Specify the line or fill color of each data segment. For Line and Area chart types, this would be a line color. For Pie and
Bar charts, this would be the fill color for each data segment.

. Outline color: Specifies the line color for the outline around any data segment. This line does not appear on all chart types or specific subtypes.

o Edit Color(s): The Edit Colors window allows you to specify the colors to be used for each of your data segments. More information on the
Edit Colors window can be found here.

Entering the pipe character:
On most keyboards, holding down the Shift key and pressing the backslash "\" key will enter the pipe character.



Dynamic

Select the Dynamic radio button if you wish to have your chart display dynamic data from a recordset.

Data
Connection: [mnnBSM "]
Data source: [nrders "]
X Label: [DrderDate "]
Group by | Year ']
Range from: 200&-1-1 |
Range to: 2008-1-1 sl
¥ Value: | orderTotal ']
Calculation | Sum "]

Dataset label: Mumber of Orders

. Connection: Choose from any database connection currently created in your Dreamweaver site.
. Data source: Choose the database table you intend to use for your chart.

. X Label: Choose the column from your database you intend to use for your X Values.

o Group by: Groups all same data in the X label column as one data point in your chart. If the database column selected in the X Label
menu contains dates, the options will be, Value, Day, Week, Month or Year. For all other database columns, Value or None are the only
options available.

1 Range from: Allows you to use the Date Picker to select the start date for any grouping by date.
o Range to: Allows you to use the Date Picker to select the end date for any grouping by date.

. Y Value: Choose the column from your database you intend to use for your Y Values.

o Calculation: Allows you to specify how you would like the values for grouped data to be presented in your chart. Options available are,
Average, Count, Max, Min, and Sum.

. Dataset label: Allows you to specify a label for your dataset.

Filtering and sorting
This section allows you to apply any filtering or sorting to your recordset to customize the way the data is displayed in your chart.

Filtering and sorting

Filter: [Nune 'r] =

URL Parameter

Sort: [None - ] Ascending

[] Show multiple datasets from column

rderID

]

. Filter: Choose from the menu list, the database column to filter your results based on. Then choose from the other 3 menu lists that
become active, the specific criteria to filter the selected column by.

. Sort: Choose the database column you intend to have your data sorted by.

. Show multiple datasets from column: Check this box and select a database column from the menu list, to have your chart data separated
based on a value in this column. This would be useful if you wanted to show total sales over a given period on your chart, but have
separate data columns for each of your products.

Styles



Styles

Dataset label style: ﬂ #767a7f
LineFill color: ﬂ #273015 Edit Color(s)
Cutline color: ﬂ #627350

. Dataset label style: Specify the type size and color for your dataset label.

. Line/Fill color: Specify the line or fill color of each data segment. For Line and Area chart types, this would be a line color. For Pie and
Bar charts, this would be the fill color for each data segment.

. Outline color: Specifies the line color for the outline around any data segment. This line does not appear on all chart types or specific subtypes.

o Edit Color(s): The Edit Colors window allows you to specify the colors to be used for each of your data segments.

Preview

The Preview pane displays a representation of your chart based on the configuration options you have specified. You can test the interactivity
of the chart by running your mouse over each data point or area. Unlike other WebAssist products, the preview is only displayed in the
Dynamic Web Charts interface and does not display in your primary browser when clicked.

Note: The Preview area only displays static data whether dynamic data is selected or not.

Preview

My Chart Title

== Support Posts

140

70

here it is

here it is




Color Editor

The Color Editor allows you to choose a number of colors that will be used when displaying each data point in your
chart.

The list displays all the colors that will be used for each data point in your chart in order (top to bottom). Once all
colors have been displayed, your chart will cycle through your color choices again for subsequent data points.

Note: For charts types other than Pie, the colors listed in the Color Editor only apply when showing multiple datasets.

Color editor

Select the colors to be used in your chart.

9= Add il Delete | ol
Colors [EP TS A

#3a32c4 |
#b0bsbd
#5456ef
| #dadbf
#c0c3ad

Color: ﬂ #2d2b2e

WEBASSIST"  [iHilens| [tk focancet

. Add: Adds a new color below the selected color.

Delete: Deletes the selected color.
Color: Use the color picker or enter a hexadecimal color code for the selected color.

Up and Down arrows: Moves the selected color up or down in the priority list.




Date Picker

The Date Picker allows you to choose a date as part of selecting a date range in the Data section of the Data tab.

Move forward or backwards by month using the month left or right arrows.
Move forward or backwards by year using the year left or right arrows.

. Click once on the day to make your selection and return to the Data tab.

4]  August [ & 2008

10 11 12 13 14 15 16

17 18 19 21 22 23

31
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AXxes

The Axes tab configures the labels and styles for the X and Y Axis. This option is not available for Pie chart types.

Dynamic Web Charts Editor

Choose the styles for each axis of your chart to be displayed.

X Axis
Legend: Enter the X Axis legend that you would like to be displayed below your X Axis data points.
Legend style: Choose the font size for your legend, and color from the color picker or by entering a hexadecimal color code.

Label style: Choose the font size and color for your X Axis labels.

1 Orientation: Choose the orientation of your X Axis data labels. Options are Horizontal, Vertical, and Angled.

1 Label every __ data points: For large datasets, you may need to limit the number of data points labeled on the X Axis. In the text field,
enter the numeric value to specify the number of data points to label. If no value is entered, every data point will be displayed.

. Axis color: Using the color picker, or by entering a hexadecimal color code in the text field, specify a color for the X Axis line.

. Grid color: Using the color picker, or by entering a hexadecimal color code in the text field, specify a color for the vertical gridlines that
extend from the X Axis.

X Axis

Legend: here itis

Legend style: ﬂ #2d2bZe
Label style: ﬂ £50516b  Orientation: | Angle +

Label every data points

Axis color: ﬂ #TaT7a7f
Grid color: ﬂ #7a7a7f

Y Axis
Legend: Enter the Y Axis legend that you would like to be displayed beside your Y Axis data points.
Legend style: Choose the font size for your legend, and color from the color picker or by entering a hexadecimal color code.
Label style: Choose the font size and color for your Y Axis labels.
. Axis color: Using the color picker, or by entering a hexadecimal color code in the text field, specify a color for the Y Axis line.

. Grid color: Using the color picker, or by entering a hexadecimal color code in the text field, specify a color for the horizontal gridlines
that extend from the Y Axis.

. Show Y Axis on left only: Select this radio button to show only one Y Axis on the left side of your graph.

. Show Y Axis on left and right: Select this radio button to show a Y Axis on the left and right sides of your graph.



Y Axis

Legend: here itis

Legend style: ﬂ #2d2bZe
Label style: ﬂ £50516b

Axis color; ﬂ #Ta7a7f
Grid colar: ﬂ #767a7f

i@ Show Y Axis left only

(™1 Show ¥ Axis on left and right

Preview

The Preview pane displays a representation of the chart based on the configuration options you have specified. Your selections on this tab
will automatically update your chart preview.




Background

The Background tab allows you to configure the background colors used in your chart.

Dynamic Web Charts Editor

Choose the background styles for your chart and the background of the data display area of your chart.

Chart Background
This section allows you to specify the background color or image used for the background of your entire chart.
. Color: Use the color picker, or enter a hexadecimal color code in the text field, to specify a background color.
Image: Enter a path, or choose the Browse icon to select a background image to use.

Positioning: Specify the positioning of your background image, by choosing the vertical alignment from the first menu list, and
horizontal alignment from the second.

Chart Background
Color: Q T

Image: ﬁ

Pasitioning: [Tnp 4 ] [LeFt -

Inner Background

This section allows you to specify the background color(s) to be used for the data region of your chart.
. Solid: Select this radio button to specify a solid background color to be used.
1 Color: Use the color picker, or enter a hexadecimal color code in the text field, to specify a background color.
. Gradient: Select this radio button to specify a gradient will be used for your background color.

» Orientation: Choose the angle in degrees that you wish your gradient to display. You can manually enter a value from 0 to 360 degrees.
o Start color: Use the color picker, or enter a hexadecimal color code in the text field, to specify the first color to be used in your gradient.
o End color: Use the color picker, or enter a hexadecimal color code in the text field, to specify the second color to be used in your gradient.
Inner Background
i Salid
Color: Q

i@ Gradient

Orientation: E -
Startcolor: | | #e3e3e4

End color: ﬂ #%a3aa

Preview

The Preview pane displays a representation of the chart based on the configuration options you have specified. Your selections on this tab
will automatically update your chart preview.




Layout Manager

The Layout Manger provides the ability to manage all the presets used in Dynamic Web Charts. This can also be used to import custom
presets, and export presets to be used in Dynamic Web Charts on other machines.

Access

The following locations in Dreamweaver open the Dynamic Web Charts Layout Manager:
. WebAssist Insert panel

&

i Cynamic Web charts Layout Manager ]

Insert > WebAssist > Dynamic Web Chart > Layout Manager
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Layout Manager

Product: [Dynamic Web Charts ‘l

Click Mew to add & Dynamic Web Chart to your page. Click Edit to modify the layout XML with the
%ML Editor, To copy a selected layout, dok Duplicate; to delete a selected layout, dick Remove, To
save ane or more selected layouts, didk Export; to refrieve previously stored layouts, dick Import.

[
Meadow E
Ocean

| Duplicate |

WEBASSIST™ | HELP | DONE |

. New: Opens the Dynamic Web Charts wizard to create a new chart layout. When a chart is selected that uses advanced features that
cannot be presented through the wizard, this opens the Quick Insert dialog box to insert the currently selected preset to your page.

Edit: Opens the selected preset in the Dynamic Web Charts wizard for editing.

Duplicate: Creates a duplicate copy of the selected preset and appends the selected name with "copy".

Remove: Removes the selected preset.

Export: Exports the selected preset to a .zip format allowing easy import into Dynamic Web Charts on different machines.

Import: Displays a Browse window allowing you to select a .zip file containing a Dynamic Web Charts preset to be imported.




Quick Insert

The Quick Insert dialog box allows you to specify the dimensions of the chart to be inserted. After choosing OK, your
chart will be inserted to your page.

. Width: Specify the width of the chart you are inserting.
Height: Specify the height of the chart you are inserting.

Dynamic Web Charts Quick Insert

Set the dimensions of your chart.

Width: 320
Height: 240

WEBASSIST"™ | owee [ ok || camncer |




XML Editor

The XML Editor is a floating panel that allows you to easily access the XML file used to generate your chart. This exposes
all the elements of your chart, so that you can customize as many details as possible.

The XML Editor allows you to easily locate a specific section of the XML file in Dreamweaver's Code view and review
available options. You can use the XML Editor to Add, Delete, Edit, Cut, Copy and Paste XML nodes. As you select specific
nodes in the XML Editor, you will notice those specific nodes also highlighted in the Code view of your Dreamweaver page.

The XML Architecture Reference page provides details on the types of editing that can be done to customize your chart.

Access

The following locations in Dreamweaver open the XML Editor:

. From the Properties Inspector (only when Dynamic Web Chart is selected on your Dreamweaver page).

. Insert > WebAssist = Dynamic Web Chart > XML Editor.

il

i w XML Editor

4= Add il Delete ;_'fEdit b Cut @ Copy (&) Paste L5 Open |zl Save | a

tag
= w_a_dwc

...... colar
...... colar
...... colar
...... colar
...... colar




WEBASSIST "

. Add: Will provide options for inserting specific XML nodes. Options available vary based on the selected node in
the XML tree structure.

. Delete: Deletes the selected XML node.

. Edit: Places your cursor in the appropriate location of your Dynamic Web Charts data page allowing you to make
modifications. More information on the available types of modifications can be found in the XML Architecture

References page.

. Cut: Cuts the selected node from the XML tree structure.
. Copy: Copies the selected node from the XML tree structure.

. Paste: Pastes the content of the most recent cut or copy procedure. Depending on your currently selected XML
node, the paste option may be unavailable.

. Open: Displays the Open Preset dialog allowing you to open a currently saved Dynamic Web Charts preset to edit
in the XML Editor.

. Save: Displays the Save Preset dialog allowing you to save your current modifications to a new Dynamic Web
Charts preset.

Note: You must choose to save your modifications using this option within the XML Editor to avoid creating
duplicate presets in the Dynamic Web Charts Layout Manager.

. Up and Down Arrows: Allows you to move the selected XML node up or down in the XML tree structure.




XML Architecture

The XML architecture supports all of the information necessary for charts to be rendered. This includes all of the
labels, axes, colors, and data. The following outlines this XML structure.

Please refer to this reference for all modifications.
<layout>

. Properties: Title - the Title to show in the layout manager list

. Description: This tag is the main root-level tag for Layouts.

. Child Tags: title, background, innerbg, numformat, xaxis, yaxis, rightyaxis, color_wheel, data
<dwc=>

. Properties:

o Layout - the XML file used for this chart’s layout
o Color - the Color XML file used for this chart’s color scheme
. Description: This tag is the main root-level tag for Dynamic Web Charts.
. Child Tags: title, background, innerbg, numformat, xaxis, yaxis, rightyaxis, color_wheel, data
<title>

. Properties: Style - font style
. Description: The title of the chart Child
. Tags: None

<background=>
. Properties:

o Color - color of the background image to use
o Align - background horizontal alignment
o Valign - background vertical alignment
. Description: The background information for this chart
. Child Tags: None

<innerbg>
. Properties:

v Startcolor - color at start of fade

o Endcolor - color at end of fade

v Direction - background fade direction
. Description: More background information for this chart
. Child Tags: None

<numformat=>
. Properties:

o Decimals - number of decimals to show



o Force - whether to force decimal places

v Comma_decimal - whether to use a comma as the point character

o No_thousand - whether or not to use the thousands place separator
. Description: How numbers are formatted
. Child Tags: None

<xaxis>
. Properties:

o Min = minimum value on the axis
o Max - maximum value on the axis
o Color - the color of the axis
v Gridcolor - the color of the grid
v Offset - true / false for starting datapoints on or offset from Y-Axis
. Description: The information for the x axis
. Child Tags: ticks, legend, labels
<yaxis>
. Properties:

o Min = minimum value on the axis
o Max - maximum value on the axis
o Color - the color of the axis
o Gridcolor - the color of the grid Offset - ?7?
. Description: The information for the y axis
. Child Tags: ticks, legend, labels
<rightyaxis>

. Properties:

o Min = minimum value on the axis

o Max - maximum value on the axis

o Color - the color of the axis

v Gridcolor - the color of the grid Offset - ??
. Description: The information for the right y axis
. Child Tags: ticks, legend, labels

<ticks>
. Properties:

o Number - number of ticks on the axis

o Width - width of tick line

o Axiswidth - width of axis line

o Showevery - how often to show the tick

. Description: The number of ticks on the axis



. Child Tags: None

<legend>
. Properties:

v Size - Font size
o Color - Font color
. Description: The number of ticks on the axis
. Child Tags: None
<labels>

. Properties:

v Size - Font size

o Fontcolor - Font Color

o Showevery — Number of ticks

o Orientation — Degrees of rotation

o Linecolor - Color of the label line ??
v Steps — Number of steps ??

. Description: Label information for the axis / pie piece - for charts that don’t have one label per point, or one
point per label, configuring the global set of X-Axis labels for datapoints is the proper method. Otherwise, if
all datasets contain values for each point, either method should work.

. Child Tags: label
<label>=
. Properties: None
. Description: Label for axis or pie piece
. Child Tags: None
<color_wheel=>
. Properties: name - name of colorwheel

. Description: Main level tag that provides the color wheel for pie or stacked data. If no color wheel is specified
each data point (pie) or data set (stacked) needs to have a color associated. Those charts with color wheels
will still allow for individual colors on a piece or set basis.

. Child Tags: color
<color=
. Properties: None
. Description: Contains color value in CDATA node
. Child Tags: CDATA
<data>
. Properties: None
. Description: Main level tag that surrounds data set(s) for single or stacked charts
. Child Tags: tooltip, dataset

<tooltip>



. Properties: None
. Description: Contains encoded string for the tooltip of values when hovered over
. Child Tags: any html, br for linebreaks, chart_value
<chart_value>
. Properties: value
. Description: contains value to display inline in tooltips

. Child Tags: None

<dataset>

. Properties:

o General: Axis — Axis to bind data values to
v Type - chart type
Line:

. Subtype - chart sub-type

. Style - Style for tooltips / values

. Width - width of data

. Color - color of the data

. Label - label for the data

. Size - size of the font

. Dotsize - size of dots for line

Bar:

. Subtype - chart sub-type

. Opacity - opacity of the bars

. Abstraction - abstraction of bars
. Color - colors of bars

. Outline - outline color of bars

. Label - label for bar

. Size - font size

Area:
. Width - width of area

. Dotsize - size of dots in area

. Opacity — opacity of area

. Color - color of dots

. Label - label for dots

. Fontsize - size of font

. Fillcolor = what color to fill the area with

Scatter:



. Dotsize - size of dots in area
. Color - color of dots
. Label - label for dots

. Size - size of font

. Opacity - opacity of area
. Width - width of area
. Color - color of dots
. Label - label for dots
. Size - size of font
High, Low, Close:
. Opacity - opacity of entries
. Width - width of entries
. Color - color of entries
. Title - label for entries
. Size - size of font
Pie:
. Opacity - opacity of pieces
. Linecolor - color of border lines
. Style - CSS Style for label
. Description: Main information about data set with chart type and other information
. Child Tags: point
<point>

. Properties: datagroup: allows the display of multiple data sets from a single data set. All point tags with the
same datagroup value will be shown as their own data sets.

. Description: Contains encoded string for the tooltip of values when hovered over
. Child Tags: value, label, color, pointlink, tip, subpoint
<subpoint>
. Properties: None
. Description: Used for charts (like Candle) that allow for multiple pieces of data per data point.
. Child Tags: value, label, color, tip, pointlink
<value>
. Properties: None
. Description: Value of a point or sub-point
. Child Tags: None
<tip>

. Properties: None



Description: Tip value for this point
Child Tags: None
<pointlink>
Properties: None
Description: Where to link to from the value on click
Child Tags: None
<color=
Properties: None
Description: Color for data point

Child Tags: None




Open/Save Presets

The XML Editor allows you to open any preset Dynamic Web Chart for customization, and save any of your custom
settings to a new preset.

Open Preset

When selecting open from the XML Editor, the following window displays:
From the Preset menu list, choose the saved preset you wish to customize using the XML Editor.

ﬁ

Select a preset to start your chart from.

Preset i% - i

Clean
Goth

Dcean

WEBASSIST™  |eMile| ok [ocancee

Save Preset

When selecting save from the XML Editor, the following window displays:

In the Preset field, enter the name for your new preset or choose a preset to overwrite from the menu list.

Precets

Enter the name of your preset,

Preset My New Chart -

WEBASSIST™  funMilee [tk |cancee




Reset to First Record

The Reset to first Record server behavior allows you to specify if you want a specific recordset to be looped over.
This may be necessary if the same recordset is used more than once by different elements on the same page.

To implement this server behavior, follow these steps:
1. From the Dreamweaver Server Behaviors panel, choose Add = Dynamic Web Charts > Reset to first

record.
2. Choose from the Recordset menu list, the Recordset you wish to reset.

=)

Reset to first record

Select the recordset you want to reset to prepare the data to be looped
through again.

Recordset: |rsSupport

.' |

WEBASSIST"™ | owee [ ok || cancer |




Properties Inspector

The Properties Inspector for Dynamic Web Charts allows you to easily update or modify your chart either using the Wizard or XML

Editor.

Re-entering the Dynamic Web Charts wizard
1. Click once on the gray chart placeholder on your Dreamweaver page.
2. Choose Edit in Wizard.

Note: When re-entering the Dynamic Web Charts wizard, Dreamweaver opens a data page as it sends Dynamic Web Charts the
details about your chart. This occurs seamlessly, but this data file will still be displayed in your Open Recent list in Dreamweaver.

Editing your chart in the XML Editor
1. Click once on the gray chart placeholder on your Dreamweaver page.
2. Choose Edit in XML Editor.

Modifying your charts dimensions

1. Click once on the gray chart placeholder on your Dreamweaver page.

2. Enter new dimensions for your chart in the height and width fields.
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